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Introduction

The SAP Business One Integration Tool Pack allows you to automate the management of your SAP Business One

company data.

You can carry out tasks such as retrieving information from a company or executing an operation to automatically

ADD, UPDATE, or DELETE items such as invoices, sales orders, or business partners. Company objects and fields can

be mapped to BPA Platform data at runtime.

When combined with other tools of BPA Platform , the SAP Business One Integration Tool Pack can also provide a

method of synchronising data between two systems that do not naturally talk to each other; for example, your SAP

Business One system and a web shop such as Magento.

The SAP Business One Integration Tool Pack Contents

The tool pack consists of:

 SAP Business One Event Agent— see About the SAP Business One Event Agent

 SAP Business One Trigger tool — see About the SAP Business One Trigger Tool

 SAP Business One (DIAPI) Integration Agent— see About the SAP Business One (DIAPI) Integration Agent

 SAP Business One (DIAPI) Integration tool — see About the SAP Business One (DIAPI) Integration Tool

 SAP Business One (SL) Integration Agent— see About the SAP Business One (SL) Integration Agent

 SAP Business One (SL) Integration tool — see About the SAP Business One (SL) Integration Tool

Features

 On-premise and cloud (both Public and Private Cloud) installations of SAP Business One supported.

 Support for user defined tables and fields within objects and sub-objects.

 Allows you to maintain the synchronisation of data between one SAP company database and another. For

example, if a record changes in one company it will be reflected in the other.

 Allows data to be synchronised between SAP Business One and third-party systems.
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 Dynamic provision of API metadata enabling changes to objects & operations to be rolled out independently

of the tool pack (SAP Business One (DIAPI) Integration tool only).

 Memory support for ODBC, OLEDB, Call Store Procedure, and internal repositories (SAP Business One

(DIAPI) Integration tool only).

System Requirements

All aspects of the SAP Business One Integration Tool Pack require BPA Platform (formerly known as "TaskCentre")

2020 Update 1 (build 6466) or above.

For a detailed description of the supported architecture for BPA Platform v. SAP Business One configurations, see

Architecture.

The supported versions of SAP Business One are as follows:

Version Supported with SQL Server Supported with SAP HANA

SAP Business One 8.82  

SAP Business One 9.0  

SAP Business One 9.1  

SAP Business One 9.2  

SAP Business One 9.3  

SAP Business One 10.0  

For more information about SAP Business One compatibility, refer to your Codeless Platforms partner or account

manager.

Architecture

The following diagrams demonstrate the possible architectures when using the SAP Business One Integration Tool

Pack with either an SQL Server or SAP HANA configuration. The following combinations of tool pack components are

valid:

 SAP Business One (DIAPI) Integration Agent and tool

 SAP Business One (SL) Integration Agent and tool

 SAP Business One (DIAPI) Integration Agent and tool and the SAP Business One (SL) Integration Agent

and tool
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 SAP Business One Event Agent, SAP Business One Trigger tool, and SAP Business One (DIAPI) Integration

Agent and tool

 All six components

SAP Business One On-Premise Configurations

The following diagrams provide an architectural overview of supported SAP Business One Integration Tool Pack

components in an SAP Business One on-premise environment.

Using aMicrosoft SQL Server Configuration

NOTE: For ease of viewing, the below assumes all relevant Tool Pack components are in use, with all SAP

Business One elements grouped together rather than residing in their respective silos. Other configurations exist

andmay be supported— for more information, contact your Codeless Platforms partner or account manager.

To monitor SAP Business One events, the SAP Business One Event Agent can be located on the same computer

hosting the required company database instance — remote installations are supported.

However, the SAP Business One (DIAPI) Integration Agentmust always be located on the same computer hosting

the SAP Business One Data Interface (DI) API; remote installations are not supported for this Agent.

Both the SAP Business One Trigger and SAP Business One (DIAPI) Integration tools must be installed on the BPA

Platform server, and also on any remote BPA Platform client computers (not shown) that run SAP Business One

tasks.
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Using an SAP HANAConfiguration

NOTE: For ease of viewing, the below assumes all relevant Tool Pack components are in use, with all SAP

Business One elements grouped together rather than residing in their respective silos. Other configurations exist

andmay be supported— for more information, contact your Codeless Platforms partner or account manager.

As before, all Agents can be located on the same computer hosting the connecting service with the exception of the

SAP Business One (DIAPI) Integration Agent whichmust be located local to the DI API service.

The SAP Business One Trigger, SAP Business One (DIAPI) Integration, and SAP Business One (SL) Integration

tools must be installed on the BPA Platform server, and also on any remote BPA Platform client computers that run

SAP Business One tasks.

SAP Business One Cloud Configurations

The following diagrams provide an architectural overview of supported SAP Business One Integration Tool Pack

components with SAP Cloud.
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SAP Private Cloud with Microsoft SQL Server

NOTE: For ease of viewing, the below assumes all relevant Tool Pack components are in use, with all SAP

Business One elements grouped together rather than residing in their respective silos. Other configurations exist

andmay be supported— for more information, contact your Codeless Platforms partner or account manager.

The BPA Platform server must be installed on a computer which is in the same secure domain and has access to the

SAP Presentation Server, for example an Application Server, or on the Presentation Server itself.

The SAP Business One Event Agent can be installed on the same computer as the BPA Platform server, or on any

remote computer in the same secure domain which has access to both BPA Platform and the relevant SAP Business

One company database in the Private Cloud environment.

The SAP Business One (DIAPI) Integration Agent, however, must be installed along-side the SAP DI API therefore

the cloud environment must make a computer available for both components.

Both the SAP Business One Trigger and SAP Business One (DIAPI) Integration tools must be installed on the BPA

Platform server, and also on any remote BPA Platform client computers (not shown) that run SAP Business One

tasks.
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SAP Private Cloud with SAP HANA

NOTE: For ease of viewing, the below assumes all relevant Tool Pack components are in use, with all SAP

Business One elements grouped together rather than residing in their respective silos. Other configurations exist

andmay be supported— for more information, contact your Codeless Platforms partner or account manager.

The BPA Platform server must be installed on a computer which is in the same secure domain and has access to the

SAP Presentation Server, for example an Application Server, or on the Presentation Server itself.

The SAP Business One (SL) Integration Agent can be installed along-side the BPA Platform server or a remote

computer (in the same secure domain) that has access to both BPA Platform and the Service Layer.

The SAP Business One Event Agent can also be installed on the BPA Platform server or a remote computer but must

have access to the SAP HANA client.

The SAP Business One (DIAPI) Integration Agent, however, must be installed along-side the SAP DI API cloud

environment must make a computer available for both components.

The SAP Business One Trigger, SAP Business One (DIAPI) Integration, and SAP Business One (SL) Integration

tools must be installed on the BPA Platform server, and also on any remote BPA Platform client computers that run

SAP Business One tasks.
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SAP Public Cloud

NOTE: For ease of viewing, the below assumes all relevant Tool Pack components are in use, with all SAP

Business One elements grouped together rather than residing in their respective silos. Other configurations exist

andmay be supported— for more information, contact your Codeless Platforms partner or account manager.

With a SAP Public Cloud environment, only a SAP Business One (SL) Integration Agent and tool deployment is

supported. The SAP Business One Event Agent cannot be deployed in this environment as triggers are not

permitted by SAP Business One. All communication is over HTTPS.

The BPA Platform server must be installed on a computer which is in the same secure domain and has access to the

SAP Presentation Server, for example an Application Server, or on the Presentation Server itself.

The SAP Business One (SL) Integration Agent can be installed along-side the BPA Platform server or a remote

computer (in the same secure domain) that has access to both BPA Platform and the Service Layer.
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About the SAP Business One Trigger Tool

The SAP Business One Trigger tool is used to trigger a task when the contents of a SAP Business One database are

modified, monitored by the SAP Business One Event Agent.

You can select which object to trigger on and also define when the trigger will fire based on the type of event the

object receives, that is, an ADD, UPDATE, DELETE, CANCEL, or CLOSE.

You can even restrict an UPDATE trigger to an event that occurs to a field of an object instead of having a task trigger

when any field receives an event (only if the object type supports history data).

Variables are used in the tool to capture any data being inserted, removed, or updated. This data can then be passed

to other steps in the task for processing.

Additionally, where an update is being applied to a field, you can choose to capture the before and after values which

can also be passed to subsequent steps in the task (only if the object type supports history data).

About the SAP Business One Event Agent

The SAP Business One Event Agent is a service that monitors a SAP Business One company database for specific

events. Once an event has been detected, it notifies the SAP Business One Trigger tool to trigger a task sequence.

You configure the triggering event types in the tool itself — see About the Main Tab.

The location of the SAP Business One Event Agent installation depends on the database environment:

 If installing to a Microsoft SQL Server environment, the SAP Business One Event Agent is typically located on

the same server running the SAP Business One company database instance it is monitoring — see Using a

Microsoft SQL Server Configuration. This is the recommended installation.

However, remote SAP Business One Event Agents (where it is installed on a separate computer to the

company database) are supported, particularly where the company database is hosted in a cloud

environment— see SAP Private Cloud with Microsoft SQL Server.

 If installing to a SAP HANA environment, the SAP Business One Event Agentmust be located on the same

server hosting the SAP HANA Client instance for the company database it is monitoring. Installing the Event

Agent directly onto the SAP HANA Server is not supported. For more information, go to Using an SAP HANA

Configuration.

Again, remote installations of the Event Agent are supported, particularly in cloud environments — see SAP

Private Cloud with SAP HANA.

When registered, the Event Agent creates its own database table, CodelessPlatforms.SBOEventAgentCommon,

containing records of the events which the SAP Business One Trigger tool then reads. Specific user credentials are

required for this — see SAP Business One Database User Credentialsrefer to the product help.

After the installation has completed, the BPA Platform Configurator is launched for immediate configuration— refer

to the product help.
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Technical Summary

Global Configuration for the SAP Business One Trigger Tool

No global configuration is required for the SAP Business One Trigger tool.

Instead, you create a connection to the SAP Business One Event Agent then to the SAP Business One company

database through the BPA Platform Configurator.

For a detailed description of how to use the Configurator and how to create the connection, refer to the product help.

Working with Other Tools

The SAP Business One Trigger tool is independent of any other steps used in a task.

Objects Consumed

Because the SAP Business One Trigger tool starts tasks, it does not consume any objects exposed by other task

steps.
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Objects Exposed

The SAP Business One Trigger step exposes the following objects, which can be used by other task steps:

 Step Properties— Standard step properties are exposed allowing you to use statistical data of the SAP

Business One Trigger step.

Step Configuration

When creating new tasks, the SAP Business One Trigger tool is located under Event of the Task Browser.

To add a new SAP Business One Trigger step to an existing task, do the following:

From the relevant task, either:

 Click and drag the SAP Business One Trigger icon from the Task Browser to the task Design area.

 From the task's Design tab, right-click on empty space and select New > Event > SAP Business One Trigger.

For a detailed description of how to create new tasks, refer to the product help.
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About theGeneral Tab

The General tab is used toName and describe (Description) this task step.

TIP: If this task instance makes use of two or more SAP Business One Trigger steps, ensure the Name used is

unique for each individual step.
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About theMain Tab

TheMain tab is used to select the SAP Business One database to monitor and the criteria required to trigger the task

to run.

From the Agent drop-down list, select the relevant SAP Business One Event Agentmonitoring the company

database. If multiple Agents are registered with this instance of BPA Platform, the monitored company database is

also shown.

The Object drop-down list is populated with the SAP Business One objects from the monitored company database.

From the drop-down list, select the object used as the trigger.

Choose the Event Type used as the trigger (multiple Event Types can be selected):

 Add— The step is triggered when a new record is added to the Object

 Delete— The step is triggered when an existing record is deleted
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 Close— The step is triggered when an existing record is closed

 Cancel— The step is triggered when an existing record is cancelled

 Update— The step is triggered when an update occurs for an existing record

You can also create Update triggers on a specific field for an object. Either:

 Select the relevant field(s) to trigger on

 Click All to trigger when all fields for that object are updated

Use None to clear the selection of all fields. Having no fields selectedmeans the step triggers when ANY field

is updated for thatObject.

Use Toggle to switch between all fields selected and none.

For a list of those objects that expose fields for use withUpdate triggering, refer to the product helpsee

Supported Objects.

TIP: You can capture the "before" values of a field (before the Update event was triggered) using variable

mapping. To capture the before value, map a variable to the previousValue field. Note that only those

objects that provide history data have the previousValue field.

Use theMapping panel to map parameter-type task variables to anObject field. These variables can then be used

in another task step. All relevant variables are shown under Name. Use the Parameter drop-down to map to the

relevant field.

Supported Objects

At the time of writing, you can place triggers on the following objects. Those objects that allowUpdate triggers to be

placed on their fields are also indicated:

SAP B1 Objects Update Trigger Allowed? Comments

Account Segmentation (OASG) US SAP only

Account Segmentation Category (OASC) US SAP only

Activity (OCLG)

Activity Location (OCLO)

Activity Status (OCLA)

Activity Type (OCLT)

Additional Expenses (OEXD)
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SAP B1 Objects Update Trigger Allowed? Comments

Admin info SAP 9.1 only

Alerts (OALT)

Alternative Catalogue Number (OSCN)

Alternative Items (OALI)

Asset Documents (OACQ)

Attachments (OATC)

Bank Code (ODSC)

Bank Pages (OBNK)

Bank Statements (OBNH)

Bar Codes (OBCD) Not supported in 8.82

Batch Number Details (OBTN)

Bill of Exchange Transaction (OBOT)

Bill of Materials (OITT) 

Bin Location Attributes Not supported in 8.82

Bin Location Fields Not supported in 8.82

Bin Locations Not supported in 8.82

Blanket Agreement (OOAT)

BP Priority (OBPP)

Budget (OBGT)

Budget Distribution (OBGD)

Budget Scenario (OBGS)

Business Partner (OCRD) 

Business Partner Group (OCRG)

Campaigns (OCPN)

Chart of Account (OACT)

Checks for Payment (OCHO) 

Choose From List (OCHF)
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SAP B1 Objects Update Trigger Allowed? Comments

Closing Date Procedure (OCDP)

Commission Group (OCOG)

Contract Template (OCTT)

Correction Invoice (OCSI) 

Correction Invoice Reversal (OCSV) 

Cost Centre (OPRC) 

Credit Card (OCRC)

Credit Card Payment (OCDT)

Credit Note (ORIN) 

Credit Payment Method (OCRP)

Currencies (OCRN)

Currency Exchange Rate SAP 9.1 only

Customer Equipment Card (OINS) 

Customs Group (OARG)

Deduction Tax Group (ODDG)

Deduction Tax Hierarchy (ODDT)

Delivery Note (ODLN) 

Draft Document (ODRF)

Dunning Letter (ODUN)

Employee Info (OHEM)

Factoring Indicator (OIDC)

Fiscal Registry ID (OCNA)

Form 1099 (OTNN)

Goods Issue (OIGE) 

Goods Receipt (OIGN) 

House Bank Account (DSC1)

Incoming Payment (ORCT)
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SAP B1 Objects Update Trigger Allowed? Comments

Industry (OOND)

Inventory Countings (OINC) 

Inventory Cycle (OCYC)

Inventory Postings (OIQR) 

Inventory Transfer Request (OWTQ)

Invoice (OINV) 

Item (OITM) 

Item Group (OITB) 

Journal Entry (OJDT) 

Journal Voucher (OBDT) 

Knowledge Base Solution (OSLT)

Landed Costs (OIPF)

Length Unit (OLGT)

Loaded Expenses (OALC)

Manufacturer (OMRC)

Material Revaluation (OMRV) 

Messages

Multi-Language Translation (OMLT)

Outgoing Payments (OVPM)

Packages Type (OPKG)

Partners Setup (OPRT)

Payment Draft (OPDF)

Payment Methods for Payment Wizard (OPYM)

Payment Results (OPEX)

Payment Term (OCTG)

Pick List (OPKL) 

Predefined Text
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SAP B1 Objects Update Trigger Allowed? Comments

Price List

Production Order (OWOR)

Project (OPRJ)

Project Management (OPMG) 

Project Management Time Sheet (OTSH) 

Purchase Correction Invoice (OCPI) 

Purchase Correction Invoice Reversal (OCPV) 

Purchase Credit Notes (ORPC) 

Purchase Delivery Notes (OPDN) 

Purchase Down Payment (ODPO) 

Purchase Invoice (OPCH) 

Purchase Order (OPOR) 

Purchase Quotations (OPQT) 

Purchase Request (OPRQ) 

Purchase Return (ORPD) 

Purchase Tax Invoice (OTPI) Russian SAP only

Query Category (OQCN)

Queue (OQUE)

Quotation (OQUT) 

Relationship (OORL)

Return (ORDN) 

Sales Down Payment (ODPI) 

Sales Forecast (OFCT)

Sales Opportunity (OOPR)

Sales Order (ORDR) 

Sales Person (OSLP)

Sales Stage (OOST)
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SAP B1 Objects Update Trigger Allowed? Comments

Sales Tax Authorities Type (OSTT)

Sales Tax Authority (OSTA)

Sales Tax Code (OSTC)

Sales Tax Invoice (OTSI) Russian SAP only

Service Call (OSCL) 

Service Contract (OCTR)

Shipping Type (OSHP)9

Special Price (OSPP)

Stock Transfer (OWTR)9

Stock Transfer Draft (ODRF)

Target Groups (OTGG)

Team (OHTM)

Territory (OTER)

Unit of Measurement Groups (OUGP) Not supported in 8.82

Unit of Measurements (OUOM) Not supported in 8.82

User (OUSR) 

User Default (OUDG)

User Fields (CUFD)

User Query (OUQR)

User Tables (OUTB) Not supported in 8.82 or 9.0

VAT Groups (OVTG)

Warehouse (OWHS) 

Warehouse Location (OLCT)

Warehouse Sublevel Codes (OWHS) Not supported in 8.82

Weight Measure (OWGT)

Withholding Tax Codes (OWHT)
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About the SAP Business One (DIAPI) Integration Tool

The SAP Business One (DIAPI) Integration tool is used to communicate with a SAP Business One server over the

Data Interface (DI) API. When used in a task, the step exposes the objects and fields of a single company database

allowing operations such as GET, ADD, UPDATE, DELETE, SEARCH, and in some circumstances, CANCEL, or CLOSE.

The SAP Business One (DIAPI) Integration tool can consume an XML or recordset data source and output XML for

subsequent task steps to consume. Before you use the SAP Business One (DIAPI) Integration tool in a task, a global

connection to SAP Business One must be established— see Global Configuration.

About the SAP Business One (DIAPI) Integration Agent

In order to communicate with the SAP Business One DI API service, youmust install the SAP Business One (DIAPI)

Integration Agent. This acts as a "go-between" between the SAP Business One server and the SAP Business One

(DIAPI) Integration tool, and runs as a service on the installed computer. Note that it is necessary to install the

Agent on the same computer hosting the DI API service — see Architecture.

Working with Other Tools

The SAP Business One (DIAPI) Integration tool can directly interact with the following tools:

Consuming fromOther Tools

The SAP Business One (DIAPI) Integration tool can consume output from the following tools:

Icon Tool Name Tool Category

Call Stored Procedure (OLEDB) Input, Data Connectors, Output, and Execute

Database Query (ODBC) Input and Data Connectors

Database Query (OLEDB) Input and Data Connectors

Database Query (HANA) Input and Data Connectors

Import Flat File Input

Import XML Document Input
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Icon Tool Name Tool Category

Retrieve Text Message Input

Convert Recordset to XML Format

Convert XML to Recordset Format

SAP Business One (DIAPI) Integration Data Connectors

SAP Business One (SL) Integration Data Connectors

Objects Consumed

The SAP Business One (DIAPI) Integration tool consumes the following objects exposed by other steps:

 XML— XML data from any BPA Platform tool capable of exposing such data (see above)

 Recordset— Tabular data from any BPA Platform tool capable of exposing such data (see above)

Exposing to Other Tools

The following tools can directly consume output from the SAP Business One (DIAPI) Integration tool:

Icon Tool Name Tool Category

Retrieve Text Message Input

Convert XML to Recordset Format

Run Microsoft Reporting Services Format

Save File Output

Web Service Connector Data Connectors

SAP Business One (DIAPI) Integration Data Connectors

SAP Business One (SL) Integration Data Connectors
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Objects Exposed

The SAP Business One (DIAPI) Integration tool outputs the following objects which can be consumed by other tools:

 InputData

The InputData document is only available if a recordset is the consumedData Source (see About the General

Tab). This contains the recordset data available for the task run.

 OutputData

The OutputData object contains two sub-objects:

 XmlString— This is the XML document produced by the tool, containing data returned from SAP

Business One for all operations. Also included are the key fields for the mapped elements affected by

the used operation— for example, if using an ADD operation, the key fields for the top-level object

instances that are created are returned— and a SupplementaryReference field for task auditing

purposes.

The mapped fields in theMapping tab (see About the Mapping Tab) define the structure of this XML

document.

 XmlSchema— This contains the output schema in XSD format.
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 ErrorData

The ErrorData object also contains two sub-objects:

 XmlString— This contains any error data reported by SAP Business One

<Error>— All errors are created as an <Error> node, with the following sub-nodes:

   <Object />— The name of the requested object

   <CODE />— The error code returned by SAP Business One

   <MESSAGE />— The corresponding error message

   <EXTENDEDINFO />— A string containing additional information about the error

   <INPUTDATA />— The header input data (excluding child nodes) mapped for the object, plus all

data contained in SupplementaryReference

</Error>

 XmlSchema— This contains the output schema in XSD format.

 Request

This object exposes the mapped object's fields for use inMemory definitions.

 ResponseData

This property is only for use when using a first generation tool — see First Generation Tool Compatibility

Options

 LastResult

This property is only for use when using a first generation tool — see First Generation Tool Compatibility

Options

 Step Properties

Standard step properties are also available allowing you to use statistical data of the SAP Business One

(DIAPI) Integration step.

Where Can the XML Output beUsed?

The incoming XML is translated into the XML format for the object and operation selected in the configuration. The

data for the linked fields is brought across into the output XML— only those fields that are linked are brought across.

The XML is passed to the Connector, which then:

 Processes the data

 Performs the operation requested

 Recieves an XML document containing the response
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Both the OutputData and ErrorData documents can be directly used by succeeding task steps that can consume

XML data, as part of an application integration or synchronisation process. To use the documents in a non-XML

consuming tool, use a Convert XML to Recordset step first to create a recordset copy of the XML data.

The XML documents are also available as consumable objects from the BPA Platform Browser (XmlString). When

used in a task step, such as Format as Text or Save File, this exposes the actual XML string.

Error Handling

Errors are written to the BPA Platform Event Log (Tasks toolbar > Event Log )). You define how errors are

handled in the Options tab of the tool.

Reasons for the errors could include:

 Web service connection errors

 User privilege errors

 Errors from the API

 Warnings andmessages from the API
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Global Configuration

The global configuration for this tool is used to create connections to a SAP Business One company database.

You open this interface from the resources tree — expand System > Tools > Data Connectors and double-click SAP

Business One (DIAPI) Integration in the items list.

When a connection is made, the available objects and operations are retrieved.

Before you can use the SAP Business One (DIAPI) Integration tool in a task step, youmust create the connection to

SAP Business One first. Click Add.

NOTE: Youmay be restricted as to the number of SAP Business One company database connections you can

create. For more information, refer to the BPA Platform product help or consult your Codeless Platforms account

manager or partner.

Using Extended Logging

Enabling this option exposes the XML parsed between the SAP Business One (DIAPI) Integration tool and SAP

Business One.
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TIP: The Event Log database table may grow substantially large as extended logging adds additional rows for

each call made to and from the Connector. To manage this, adjust the maintenance routine for the Event Log —

refer to the BPA Platform product help.

Without extended logging, the Event Log only contains start and end of transactionmessages, plus any error

messages encountered at runtime.

You can view the extended log in the BPA Platform Event Log (Tasks toolbar > Event Log ).

About the Connection Tab

The Connection tab requires you to specify where the Integration Agent has been installed so communication can

be established with SAP Business One.

Enter a meaningful Connection Name for this Agent connection; this is the name displayed when adding task steps

for SAP Business One.

Specify the Integration Agent Servername — as hostname, IP address, or URL. This should be the machine also

hosting the DI API for SAP Business One.

By default, the connection to the Agent is over HTTP on TCP port 4205. Use the Advanced button to either Set a

Custom Port Number if 4205 is already in use in your network, or to Use HTTPS to communicate to the Agent. This

feature is particularly important if your SAP Business One instance is behind a firewall andmakes use of Network
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Address Translation (NAT) — in this scenario, add the exposed port number here instead of the SAP instance port

number.

About the Licence Server Tab

NOTE: The configuration found in the Licence Server tab is only required if connecting to SAP Business One v9.3

or earlier or for those running the SAP Business One Integration Tool Pack v3.11 or earlier. Connections to SAP

Business One v10 or higher can skip this tab.

If connecting to SAP Business One v9.3 or earlier, select Specify Licence Server Details and enter the following for

the SAP Business One License Manager Server; the License Manager Server must be the one managing the SAP

Business One user account assigned to this Agent (see About the Authentication Tab):

 Licence Server—Hostname, IP address, or URL

 Port Number
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About theDatabase Tab

The Database tab requires the location of your SAP Business One company databases along with the credentials of

an account with access to the database specified.

Enter the Backend Server Name for the SAP Business One database instance; for SAP HANA databases, this is the

name you have registered this server with in the SAP Landscape Directory (SLD). This field is case-sensitive andmust

match the name exactly. Use the following formats:

 For SQL Server connections, all SAP Business One versions — <hostname_or_URL>

Use of the IP address for SQL Server connections is not supported by SAP Business One

 For HANA v9.3 or earlier — <hostname_or_IP_address>:<port>

For example, SAP93-1:30015

 For HANA v10.0 or higher — <hostname_or_IP_address_or_URL>:<port>

For example, SAP10-1:30015

 For HANA v10.0 or higher, with multi-tenancy — <tenant>@<hostname_or_IP_address_or_

URL>:<port>

For example, HDB@SAP10-1:30013

Provide the credentials for the above database, in the form of the administrator's Username and Password. This

user must have read and write access to the relevant tenant's company database.
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It is recommended you use the Detect button to accurately detect the Backend Server Version, rather than

selecting from the drop-down. This is used to validate the supplied information, and to detect the available SAP

Business One company databases.

About the Authentication Tab

The Authentication tab requires the credentials of a SAP Business One user account used to access the database

specified in the Database tab.

Enter the Username and Password for BPA Platform to use when accessing the SAP Business One company

database.
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About the Company Tab

Once the database location and authentication has been provided the Company tab will provide a list of all available

SAP Business One company databases.

Using the Select Company drop-down list, you select the company (database) to use as the data source.

Update Objects and Operations

Enabling Update Objects and Operations allows the SAP Business One schema in BPA Platform to be refreshed

every time an update is made in SAP Business One itself.

Should you also upgrade SAP Business One to a newer, compatible version, all related schemas within BPA Platform

must be refreshed.

The schemas are refreshed when this selection and change has been saved. Youmust repeat this for each existing

connection you have defined.

NOTE: After enabling Update Objects and Operations, youmust refresh the schema in each SAP Business

One (DIAPI) Integration task step. You do this in theMapping tab (Schema Refresh) — see About the Mapping

Tab.
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Step Configuration

When creating new tasks, the SAP Business One (DIAPI) Integration tool is located under Data Connectors of the

Task Browser.

To add a new SAP Business One (DIAPI) Integration step to an existing task, do the following:

From the relevant task, either:

 Click and drag the SAP Business One (DIAPI) Integration icon from the Task Browser to the task Design

area.

 From the task's Design tab, right-click on empty space and select New > Data Connectors > SAP Business One

(DIAPI) Integration.

For a detailed description of how to create new tasks, refer to the product help.

NOTE: It is not possible to add the tool into the task until at least one connection to a company database has

been defined in the tool's Global Configuration— see Global Configuration.
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About theGeneral Tab

Use the General tab to choose the BPA Platform data source to be mapped to the SAP Business One objects. You can

map data source objects from either an XML or recordset source.

Provide a meaningful Name andDescription for this step.

TIP: If this task instance makes use of two or more SAP Business One (DIAPI) Integration steps, ensure the

Name used is unique for each individual step.

Data source can either be:

 No data source— If you don’t make use of a dedicated XML or recordset input source, select this option to

use BPA Platform variables in place of the XML or recordset objects’ fields.

For example, you can extract various bits of information from an email and store them in BPA Platform

variables. The variables are mapped to SAP Business One operational objects and fields to store in the

database for later use.

 Task step— The data source can be set to an available BPA Platform XML or recordset data source.

Only those steps that are capable of natively exposing an XML document or recordset at runtime are listed.

This may be another SAP Business One (DIAPI) Integration step, or a tool such as Retrieve Text Message or

Database Query (ODBC).
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 Custom schema— If using a recordset input data source, this option does not apply. An XML schema defines

the structure of the parsed XML: what tags are present, and the nesting of the tags. YouDefine the schema of

the XML that is used as the input data source for this step. The SAP Business One (DIAPI) Integration tool

uses the industry standard XSD format. Any XML processed by this stepmust conform to this schema else an

error will be reported.

If the XSD schema is available, either import it into the Custom Schema Configuration (use the Import

XSD/XML File button), or copy and paste it into the configuration box.

If the XSD schema is not available, you can import an example of the runtime XML (Import XSD/XML File), or

copy and paste it into the configuration box. Use the Parse button to create the schema.

 Input source variable— If using a recordset input data source, this option does not apply. As well as

defining the schema, specify the BPA Platform variable that contains the XML data at runtime.
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About the Connection Tab

You specify the SAP Business One Connection this stepmust use.

All connections created in the global configuration window are presented here.

Alternatively, you can use a BPA Platform variable or formula to create a dynamic connection, where the connection

used is determined by runtime circumstances. At runtime, the contents of the variable must match the name of one

of the Global Configuration connections — this is case-sensitive.

About the Recordset Tab

The Recordset tab is only available when a recordset is chosen as the Data Source in the General tab . SAP

Business One only accepts XML from the SAP Business One (DIAPI) Integration tool, therefore youmust use this tab

to create the XML structure expected by theMapping tab based on the parent and child relationships of an SAP

Business One object.

NOTE:Grand-parenting, that is, having an XML depth of more than one level, is not permitted.

An additional feature is that you can create an XML structure to enable looping on child elements of an object — for

example, adding multiple addresses and contact details to a single business partner. For such a case, you would

create the structure with a parent Key element which determine when a new header is found. For more information,

refer to our knowledge base article, The recommended SQL structure to generate multiple child records.
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The Recordset Columns pane displays the recordset columns as a flat list; the XML Structure pane displays the XML

as you build it.

Select Enable Recordset Shaping to map recordset data to an XML structure. However, if your recordset data is of

a simple structure, that is the recordset columns map to a flat XML structure, skip directly to theMapping tab.

The SAP Business One (DIAPI) Integration tool creates a basic XML structure based on the recordset data source.

To set an XML element as the key, right-click on the XML element (right-hand pane) and select Set as Key.

TIP: If the XML structure you are creating contains multiple child elements, remove the XML elements from the

XML structure now (right-click on the field and select Remove) to ensure you don't create duplicate elements.

To create a new child element, right-click on the required recordset column name and select Add new child

element.

Provide a Name for the child element. This has a maximum of 64 characters and uses XML-supported characters

only. The new child element appears in the XML Structure pane with the chosen recordset column as a field.

To add a recordset column to the new child node, right-click on the relevant column name and select Add to. Repeat

until the child element has been built.

To remove a field from a child element, right-click on the field in the XML Structure pane and select Remove. To

remove a child element in its entirety, youmust remove each field first. Removing the final field removes the child

element.
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About theMapping Tab

TheMapping tab is used to define links between the incoming XML or recordset data source, and the outgoing data

that is to be sent to SAP Business One. Variables can also be included as an additional source for passing data

across.

The Object drop-down shows the SAP Business One objects. If exposed, user-defined fields, objects, and tables are

also made available for selection here. The Operations drop-down shows the operations available for the selected

Object

Further down, the left-hand XML tree structure shows those data source fields available for mapping . The right-hand

XML tree structure displays those input fields for the selectedObject andOperation.

TIP: If you have selectedNo data source in the General tab, youmust add BPA Platform formulas and variables

to the left-hand data source XML tree structure before mapping.

Creating Mappings

Create links by dragging and dropping a data source field (left) onto its corresponding SAP Business One (DIAPI)

Integration input field (right). Only linked fields are used in the output XML.

BPA Platform formulas and variables can be included in the source data even when using a Task step or Custom

schema— drag them from the BPA Platform Browser to the data source’s XML; these can then be linked to the

relevant input fields. BPA Platform recordsets must first be converted to XML using either the Convert Recordset to

XML or TransformData tool before they can be used here.
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Each operation has an additional field, SupplementaryReference, which allows for traceability when transferring

data from one place to another. Whenmapped, the data resides locally at runtime. It is added to the output, and

creates a record for reference purposes only — you can choose to map any field to SupplementaryReference to

assist with checking where the data originated from or at what time the data transfer occurred, for example.

The SAP Business One (DIAPI) Integration tool uses eXtensible Stylesheet Language Transformations (XSLT) to

translate the received XML. The Advanced Translations (XSLT) tab shows the XSLT generated for the links created

for the object and operation. Use Enable Free Type Mode to directly edit the XSLT — this is particularly useful when

translating a non-standard requirement.

Refreshing the SAP Business One (DIAPI) Integration's Schema

If new fields, objects, and operations have been added to your SAP Business One company database after this task

step was originally created, use Schema Refresh to make the latest API metadata available for use.

About User-Defined Objects

The SAP Business One (DIAPI) Integration tool supports the use of user-defined objects, whether createdmanually

or imported from an external source into SAP. User-defined objects are exposed in the tool via the Object drop-

down. They appear at the top of the list and are prefixed with a # symbol.

Each user-defined object contains the mandatory operations Add and Update, along with any other operation defined

during its creation.

Any user-defined object that has the Log option enabled in SAP Business One has access to history data. Using the

SAP Business One (DIAPI) Integration tool, you can retrieve the previous value of a field after an update occurs by

mapping a variable to it.

NOTE:Newly defined objects are not automatically available for mapping. Youmust restart the SAP Business

One (DIAPI) Integration Agent service for that company database, and ensure Update objects and operations

is selected in the Global Configuration interface (see Update Objects and Operations) to make them available.
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About User-Defined Tables

The SAP Business One (DIAPI) Integration tool supports the use of user-defined tables. A user-defined table is

exposed in the tool via the Object drop-down. It appears at the top of the list and is prefixed with an @ symbol.

Selecting the table followed by an operation presents your custom fields within the right-hand pane.

NOTE:Newly defined tables are not automatically available for mapping. Youmust restart the SAP Business One

(DIAPI) Integration Agent service for that company database, and ensure Update objects and operations is

selected in the Global Configuration interface (see Update Objects and Operations) to make them available.

About User-Defined Fields

The SAP Business One (DIAPI) Integration tool supports the use of user-defined fields. A user-defined field that has

been inserted into an existing object or sub-object is exposed in the XML structure of the right-hand pane, after the

object has been selected. The field is prefixed with U_.
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About Using Memory

TheMemory button allows one of the following memory types to be added to the step:

 OLEDB Memory

 ODBC Memory

 Call Stored Procedure Memory

 Internal Memory

Memory definitions can be used to specify data to be memorised when processed by a SAP Business One (DIAPI)

Integration step at runtime. The captured data is then passed into the relevant destination location, whether that is a

defined SQL Server database table or an internal repository within BPA Platform.
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With the SAP Business One (DIAPI) Integration tool it is possible to memorise inputs to the tool step, as well as the

following outputs relating to the response from the call to SAP Business One:

Output Description

ObjectCode Not returned on failure

Not returned for Search or GetList operations

RequestFailed Returns 0 on success

Returns -1 on failure

ErrorMessage Blank on success

ErrorMessageExtended Blank on success

ErrorCode Blank on success

Use of theMemory option in the SAP Business One (DIAPI) Integration tool alters the processing method of the

step at runtime. By default, the SAP Business One (DIAPI) Integration step submits its data to SAP Business One in a

single XML request; when theMemory option is defined, each record is processed on a row by row basis.

NOTE: If using both SAP Business One (DIAPI) Integration inputs and outputs withinMemory, the SAP Business

One request is sent BEFORE Memory processing starts. This is because it must make the call in order to obtain

the response data to be used in the Memory processing. If a Memory failure subsequently occurs at runtime,

then this can result in the rows included in that call still being processed within SAP Business One.

If inputs alone are used inMemory, then the Memory processing starts first, and if successful, then the request to

SAP Business One is sent.

Supported Objects

The objects and operations currently available are shown in the table below, where:

Key for Standard Operations

A— Add GK— GetByKey

Cl— Close GL— GetList

Ca— Cancel S— Search

DR— Delete / Remove U— Update

G— Get

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Account

Segmentation

(OASG)

     US SAP only

Account

Segmentation

Category

(OASC)

     US SAP only

Activity (OCLG)    

Activity

Location

(OCLO)

   

Activity Status

(OCLA)

   

Activity Type

(OCLT)

   

Additional

Expenses

(OEXD)

    

Admin Info

(OADM)

Supported operations:
GetAdminInfo

UpdateAdminInfo

Alerts (OALT) Supported operations:
GetAlertManagment

UpdateAlertManagment

AddAlertManagment

GetAlertManagmentList

Alternative

Catalogue

Number

(OSCN)

    

Alternative

Items (OALI)

 Additional supported operations:
AddItem

DeleteItem

GetItem

40 of 103



SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Asset

Documents

(OACQ)

      

Attachments

(OATC)

   

Bank Code

(ODSC)

    

Bank Pages

(OBNK)

    

Bank

Statements

(OBNH)

 Additional supported operations:
AddBankStatement

DeleteBankStatement

GetBankStatement

GetBankStatementList

Bar Codes

(OBCD)

     Not supported in 8.82

Batch Number

Details (OBTN)

 

Bill of

Exchange

Transaction

(OBOT)

  

Bill of Materials

(OITT)

    

Bin Location

Attributes

(OBAT)

     Not supported in 8.82

Bin Location

Fields (OBFC)

   Not supported in 8.82

Bin Locations

(OBIN)

     Not supported in 8.82
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Blanket

Agreement

(OOAT)

 Additional supported operations:
AddBlanketAgreement

GetBlanketAgreement

GetBlanketAgreementList

BP Priority

(OBPP)

    

Budget (OBGT)     

Budget

Distribution

(OBGD)

     

Budget

Scenario

(OBGS)

     

Business

Partner (OCRD)

    

Business

Partner Group

(OCRG)

    

Campaigns

(OCPN)

    

Chart of

Account

(OACT)

   

Checks for

Payment

(OCHO)

      

Choose From

List (OCHF)

    

Closing Date

Procedure

(OCDP)

 
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Commission

Group (OCOG)

    

Contract

Template

(OCTT)

   

Correction

Invoice (OCSI)

   

Correction

Invoice

Reversal

(OCSV)

   

Cost Centre

(OPRC)

Supported operations:
AddProfitCenter

UpdateProfitCenter

DeleteProfitCenter

GetProfitCenter

GetProfitCenterList

Credit Card

(OCRC)

   

Credit Card

Payment

(OCDT)

    

Credit Note

(ORIN)

    

Credit Payment

Method (OCRP)

    

Currencies

(OCRN)

    

Currency

Exchange Rate

   SAP 9.1 only

Customer

Equipment

Card (OINS)

    
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Customs Group

(OARG)

   

Deduction Tax

Group (ODDG)

   

Deduction Tax

Hierarchy

(ODDT)

   

Delivery Note

(ODLN)

    

Deposits

Service

Supported operations:
GetDeposit

AddDeposit

UpdateDeposit

CancelDeposit

GetDepositList

CancelCheckRow

CancelDepositbyCurrentSystemDat

e

CancelCheckRowbyCurrentSystemDa

te

Draft

Document

(ODRF)

    

Dunning Letter

(ODUN)

    

Employee Info

(OHEM)

    

Factoring

Indicator

(OIDC)

   

Fiscal Registry

ID (OCNA)

    

Form 1099

(OTNN)

    
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Goods Issue

(OIGE)

   

Goods Receipt

(OIGN)

   

House Bank

Account (DSC1)

    

Incoming

Payment

(ORCT)

    

Industry

(OOND)

   

Inventory

Countings

(OINC)

   

Inventory Cycle

(OCYC)

    

Inventory

Postings (OIQR)

    SAP 9.1 supports only GetList

Inventory

Transfer

Request

(OWTQ)

    

Invoice (OINV)    

Item (OITM)      

Item Group

(OITB)

    

Journal Entry

(OJDT)

   

Journal

Voucher

(OBTD)


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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Knowledge

Base Solution

(OSLT)

    

Landed Costs

(OIPF)

Supported operations are:
AddLandedCost

UpdateLandedCost

GetLandedCost

GetLandedCostList

CloseLandedCost

CancelLandedCost

SAP 9.1 supports only GetList

Length Unit

(OLGT)

    

Loaded

Expenses

(OALC)

   

Manufacturer

(OMRC)

   

Material

Revaluation

(OMRV)

    SAP 9.1 supports only GetList

Material

Revaluation

FIFO

Single supported operation:
GetMaterialRevaluationFIFO

Messages Supported operations:
GetInbox

GetOutbox

GetSentMessages

GetMessage

SendMessage

Multi-Language

Translation

(OMLT)

    
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Outgoing

Payments

(OVPM)

    

Packages Type

(OPKG)

    

Partners Setup

(OPRT)

    

Payment Draft

(OPDF)

    

Payment

Methods for

Payment

Wizard (OPYM)

    

Payment

Results (OPEX)

 

Payment Term

(OCTG)

    

Pick List (OPKL)     

Predefined

Text (OPDT)

 Additional supported operations:
AddPredefinedText

DeletePredefinedText

GetPredefinedText

GetPredefinedTextList

Price List

(OPLN)

   

Production

Order (OWOR)

    

Project (OPRJ)  
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Project

Management

(OPMG)

Supported operations:
GetProject

AddProject

UpdateProject

CancelProject

GetSubProjectList

GetSubProject

AddSubProject

UpdateSubProject

DeleteSubProject

Project

Management

Configuration

Supported operations:
GetSubprojectTypes

AddSubprojectTypes

UpdateSubProjectTypes

DeleteSubProjectTypes

GetStageTypes

AddStageTypes

UpdateStageTypes

DeleteStageTypes

GetAreas

AddAreas

UpdateAreas

DeleteAreas

GetPriorities

AddPriorities

UpdatePriorities

DeletePriorities

GetActivities

AddActivities

UpdateActivities

DeleteActivities

GetTasks

AddTasks

UpdateTasks

DeleteTasks
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Project

Management

Time Sheet

(OTSH)

Supported operations:
AddTimesheet

UpdateTimesheet

DeleteTimesheet

GetTimesheet

Purchase

Correction

Invoice (OCPI)

   

Purchase

Correction

Invoice

Reversal

(OCPV)

   

Purchase

Credit Notes

(ORPC)

   

Purchase

Delivery Notes

(OPDN)

    

Purchase Down

Payment

(ODPO)

   

Purchase

Invoice (OPCH)

   

Purchase

Order (OPOR)

     

Purchase

Quotations

(OPQT)

     

Purchase

Request

(OPRQ)

     

Purchase

Return (ORPD)

    
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Purchase Tax

Invoice (OTPI)

     Russian SAP only

Query

Category

(OQCN)

   

Queue (OQUE)    

Quotation

(OQUT)

     

Relationship

(OORL)

    

Return (ORDN)     

Sales Down

Payment

(ODPI)

   

Sales Forecast

(OFCT)

    

Sales

Opportunity

(OOPR)

    

Sales Order

(ORDR)

     

Sales Person

(OSLP)

    

Sales Stage

(OOST)

   

Sales Tax

Authorities

Type (OSTT)

   

Sales Tax

Authority

(OSTA)

   
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SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

Sales Tax Code

(OSTC)

   

Sales Tax

Invoice (OTSI)

     Russian SAP only

Serial Numbers

(OSRN)

 

Service Call

(OSCL)

   

Service

Contract

(OCTR)

   

Shipping Type

(OSHP)

   

Special Price

(OSPP)

    

Stock Transfer

(OWTR)

    

Stock Transfer

Draft (ODRF)

    

Target Groups

(OTGG)

    

Team (OHTM)     

Territory

(OTER)

    

Unit of

Measurement

Groups (OUGP)

     Not supported in 8.82

Unit of

Measurements

(OUOM)

     Not supported in 8.82

51 of 103



SAP B1 Objects
Standard Operations

Comments
G GK GL A U DR S Ca Cl

User Tables

(OUTB)

     Not supported in 8.82 or 9.0

User (OUSR)     

User Default

(OUDG)

    

User Fields

(CUFD)

    

User Query

(OUQR)

    

VAT Groups

(OVTG)

    

Warehouse

(OWHS)

    

Warehouse

Location

(OLCT)

   

Warehouse

Sublevel Codes

(OWHS)

     Not supported in 8.82

Weight

Measure

(OWGT)

    

Withholding

Tax Codes

(OWHT)

    
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About theOptions Tab

The Options tab allows you to define how errors in this step are handled at task runtime.

If an error occurs, you can decide whether the step should Continue processing, or terminate the step immediately

(Abort Step).

If the step is aborted, you can choose to Continue processing onto the next step in the task, or terminate the

whole task immediately (Abort Task). By allowing the task to Continue, you can use the error XML received back in a

Save File step for investigation purposes, for example.

First Generation Tool Compatibility Options

The configuration under the First Generation Tool Compatibility Options panel is only required when converting

from older generation tools. For more information, refer to your account manager or business partner.

The parameters are grouped according to SAP Business One operations:

 Add / Update Operations Only

 Write compatible XML output to a variable— Select this option if you want to write the output

from an ADD or UPDATE operation to a task variable. This variable cannot be a Datafile or Password

type (for more information, refer to the BPA Platform product help).

 Expose compatible output Recordset (disables Memory feature)— Typically, output from the SAP

Business One (DIAPI) Integration tool is in XML form. Selecting this option also exposes a BPA
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Platform recordset version for use in later task steps. This is only for ADD or UPDATE operations. Note

that theMemory feature does not work if outputting to recordset as well (for more information, refer

to the BPA Platform product help).

 Display RetKey and RetType fields in Output Data content where available— Select to include

the Return Key and Return Type fields (note that these may not be available for every object) in the

output XML for ADD and UPDATE operations only.

 All Operations

 Process an empty input recordset as a single empty row— If the input data source (see About the

General Tab) doesn't return a recordset, for example, a Database Query (ODBC) step returning no

rows, you can choose whether to send a single empty row.
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About the SAP Business One (SL) Integration Tool

The SAP Business One (SL) Integration tool is used to communicate with a SAP Business One server over the

Service Layer. When used in a task, the step exposes the objects and fields of a single company database allowing

operations such as ADD, UPDATE, DELETE, SEARCH, and in some circumstances, CANCEL, or CLOSE.

The SAP Business One (SL) Integration tool can consume an XML or recordset data source and output XML for

subsequent task steps to consume. Before you use the SAP Business One (SL) Integration tool in a task, a global

connection to SAP Business One must be established— see Global Configuration.

About the SAP Business One (SL) Integration Agent

In order to communicate with the SAP Business One Service Layer, youmust install the SAP Business One (SL)

Integration Agent. This acts as a "go-between" between the SAP Business One server and the SAP Business One

(SL) Integration tool, and runs as a service on the installed computer. Note that it is not necessary to install the

Agent on the BPA Platform server — see Architecture.

Working with Other Tools

The SAP Business One (SL) Integration tool can directly interact with the following tools:

Consuming fromOther Tools

The SAP Business One (SL) Integration tool can consume output from the following tools:

Icon Tool Name Tool Category

Call Stored Procedure (OLEDB) Input, Data Connectors, Output, and Execute

Database Query (ODBC) Input and Data Connectors

Database Query (OLEDB) Input and Data Connectors

Database Query (HANA) Input and Data Connectors

Import Flat File Input

Import XML Document Input
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Icon Tool Name Tool Category

Retrieve Text Message Input

Convert Recordset to XML Format

Convert XML to Recordset Format

SAP Business One (DIAPI) Integration Data Connectors

SAP Business One (SL) Integration Data Connectors

Objects Consumed

The SAP Business One (SL) Integration tool consumes the following objects exposed by other steps:

 XML— XML data from any BPA Platform tool capable of exposing such data (see above)

 Recordset— Tabular data from any BPA Platform tool capable of exposing such data (see above)

Exposing to Other Tools

The following tools can directly consume output from the SAP Business One (SL) Integration tool:

Icon Tool Name Tool Category

Retrieve Text Message Input

Convert XML to Recordset Format

Run Microsoft Reporting Services Format

Save File Output

Web Service Connector Data Connectors

SAP Business One (DIAPI) Integration Data Connectors

SAP Business One (SL) Integration Data Connectors
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Objects Exposed

The SAP Business One (SL) Integration tool outputs the following objects which can be consumed by other tools:

 InputData

The InputData document is only available if a recordset is the consumedData Source (see About the General

Tab). This contains the recordset data available for the task run.

 OutputData

The OutputData object contains two sub-objects:

 XmlString— This is the XML document produced by the tool, containing data returned from SAP

Business One for all operations. Also included are the key fields for the mapped elements affected by

the used operation— for example, if using an ADD operation, the key fields for the top-level object

instances that are created are returned— and a SupplementaryReference field for task auditing

purposes.

The mapped fields in theMapping tab (see About the Mapping Tab) define the structure of this XML

document.

 XmlSchema— This contains the output schema in XSD format.

 ErrorData

The ErrorData object also contains two sub-objects:

 XmlString— This contains any error data reported by SAP Business One

<Error>— All errors are created as an <Error> node, with the following sub-nodes:
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   <Object />— The name of the requested object

   <CODE />— The error code returned by SAP Business One

   <MESSAGE />— The corresponding error message

   <EXTENDEDINFO />— A string containing additional information about the error

   <INPUTDATA />— The header input data (excluding child nodes) mapped for the object, plus all

data contained in SupplementaryReference

</Error>

 XmlSchema— This contains the output schema in XSD format.

 Step Properties

Standard step properties are also available allowing you to use statistical data of the SAP Business One (SL)

Integration step.

Where Can the XML Output beUsed?

The incoming XML is translated into the XML format for the object and operation selected in the configuration. The

data for the linked fields is brought across into the output XML— only those fields that are linked are brought across.

The XML is passed to the Connector, which then:

 Processes the data

 Performs the operation requested

 Recieves an XML document containing the response

Both the OutputData and ErrorData documents can be directly used by succeeding task steps that can consume

XML data, as part of an application integration or synchronisation process. To use the documents in a non-XML

consuming tool, use a Convert XML to Recordset step first to create a recordset copy of the XML data.

The XML documents are also available as consumable objects from the BPA Platform Browser (XmlString). When

used in a task step, such as Format as Text or Save File, this exposes the actual XML string.

Error Handling

Errors are written to the BPA Platform Event Log (Tasks toolbar > Event Log )). You define how errors are

handled in the Options tab of the tool.

Reasons for the errors could include:

 Web service connection errors

 User privilege errors

 Errors from the API
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 Warnings andmessages from the API

Global Configuration

The global configuration for this tool is used to create connections to a SAP Business One company database.

You access the SAP Business One (SL) Integration – Global Configuration window by either:

You open this interface from the resources tree — expand System > Tools > Data Connectors and double-click SAP

Business One (SL) Integration in the items list.

When a connection is made, the available objects and operations are retrieved.

Before you can use the SAP Business One (SL) Integration tool in a task step, youmust create the connection to SAP

Business One first. Click Add.

NOTE: Youmay be restricted as to the number of SAP Business One company database connections you can

create. For more information, refer to the BPA Platform product help or consult your Codeless Platforms account

manager or partner.

Using Extended Logging

Enabling this option exposes the XML parsed between the SAP Business One (SL) Integration tool and SAP Business

One.
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TIP: The Event Log database table may grow substantially large as extended logging adds additional rows for

each call made to and from the Connector. To manage this, adjust the maintenance routine for the Event Log —

refer to the BPA Platform product help.

Without extended logging, the Event Log only contains start and end of transactionmessages, plus any error

messages encountered at runtime.

You can view the extended log in the BPA Platform Event Log (Tasks toolbar > Event Log ).

About the Agent Connection Tab

The Agent Connection tab requires you to specify where the Integration agent has been installed so communication

can be established with SAP Business One.

Enter a meaningful Connection Name for this agent connection; this is the name displayed when adding task steps

for SAP Business One.

Specify the Integration Agent Server as hostname, IP address, or URL. Typically, this is the BPA Platform server but

remote installations are also supported. Note that you cannot install the Agent into the same machine hosting the

Service Layer for SAP HANA as this is a Linux machine.

By default, the connection to the Agent is over HTTP on TCP port 4209. Use the Advanced button to either Set a

Custom Port Number if 4209 is already in use in your network, or to Use HTTPS to communicate to the Agent. This
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feature is particularly important if your SAP Business One instance is behind a firewall andmakes use of Network

Address Translation (NAT) — in this scenario, add the exposed port number here instead of the SAP instance port

number.

About the Service Layer Tab

The Service Layer tab requires the location of the SAP Service Layer.

Specify Server Address as hostname, IP address, or URL.

By default, the connection is over HTTP on TCP port 50000. Use the Advanced button to either Set a Custom Port

Number if 50000 is already in use in your network, or to Use HTTPS to communicate to the Agent. This feature is

particularly important if your Service Layer machine is behind a firewall andmakes use of Network Address

Translation (NAT) — in this scenario, add the exposed port number here instead of the SAP instance port number.
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About the Authentication Tab

The Authentication tab requires the credentials of a SAP Business One user account used to access the company

database.

Enter the Username and Password for BPA Platform to use when accessing the SAP Business One company

database.

Enter the Company Database this instance of the SAP Business One (SL) Integration tool interacts with. Note that

this is case-sensitive.

Test Connection

Use Test Connection to ensure all entered details are correct and a connection to the various aspects of SAP

Business One can be established.

Update Objects and Operations

Enabling Update Objects and Operations allows the SAP Business One schema in BPA Platform to be refreshed

every time an update is made in SAP Business One itself.

Should you also upgrade SAP Business One to a newer, compatible version, all related schemas within BPA Platform

must be refreshed.

The schemas are refreshed when this selection and change has been saved. Youmust repeat this for each existing

connection you have defined.
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NOTE: After enabling Update Objects and Operations, youmust refresh the schema in each SAP Business

One (SL) Integration task step. You do this in theMapping tab (Schema Refresh) — see About the Mapping Tab.

Clear Metadata Cache

For each object mapped, the metadata is requested and downloaded from the SAP Business One Service Layer. This

is cached locally to the SAP Business One (SL) Integration Agent in C:\Program Files (x86)\SAP Business One (SL)

Integration Agent\MetadataCache (unless a custom folder was specified at installation time). This allows the SAP

Business One (SL) Integration tool to quickly populate its Objects list and input fields when the step is opened, rather

than pulling down from the Service Layer each time.

If user-defined fields (UDF), objects (UDO), or tables (UDT) are added to a mapped SAP Business One object, they

won't appear until the cache is reset (Clear Metadata Cache) even if you enable Update Object and Operations.

Step Configuration

When creating new tasks, the SAP Business One (SL) Integration tool is located under Data Connectors of the Task

Browser.

To add a new SAP Business One (SL) Integration step to an existing task, do the following:

From the relevant task, either:

 Click and drag the SAP Business One (SL) Integration icon from the Task Browser to the task Design area.

 From the task's Design tab, right-click on empty space and select New > Data Connectors > SAP Business One

(SL) Integration.

For a detailed description of how to create new tasks, refer to the product help.

NOTE: It is not possible to add the tool into the task until at least one connection to a company database has

been defined in the tool's Global Configuration— see Global Configuration.
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About theGeneral Tab

Use the General tab to choose the BPA Platform data source to be mapped to the SAP Business One objects. You can

map data source objects from either an XML or recordset source.

Provide a meaningful Name andDescription for this step.

TIP: If this task instance makes use of two or more SAP Business One (SL) Integration steps, ensure the Name

used is unique for each individual step.

Data source can either be:

 No data source— If you don’t make use of a dedicated XML or recordset input source, select this option to

use BPA Platform variables in place of the XML or recordset objects’ fields.

For example, you can extract various bits of information from an email and store them in BPA Platform

variables. The variables are mapped to SAP Business One operational objects and fields to store in the

database for later use.

 Task step— The data source can be set to an available BPA Platform XML or recordset data source.

Only those steps that are capable of natively exposing an XML document or recordset at runtime are listed.

This may be another SAP Business One (SL) Integration step, or a tool such as Retrieve Text Message or

Database Query (ODBC).
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 Custom schema— If using a recordset input data source, this option does not apply. An XML schema defines

the structure of the parsed XML: what tags are present, and the nesting of the tags. YouDefine the schema of

the XML that is used as the input data source for this step. The SAP Business One (SL) Integration tool uses

the industry standard XSD format. Any XML processed by this stepmust conform to this schema else an error

will be reported.

If the XSD schema is available, either import it into the Custom Schema Configuration (use the Import

XSD/XML File button), or copy and paste it into the configuration box.

If the XSD schema is not available, you can import an example of the runtime XML (Import XSD/XML File), or

copy and paste it into the configuration box. Use the Parse button to create the schema.

 Input source variable— If using a recordset input data source, this option does not apply. As well as

defining the schema, specify the BPA Platform variable that contains the XML data at runtime.
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About the Connection Tab

You specify the SAP Business One Connection this stepmust use.

All connections created in the global configuration window are presented here.

Alternatively, you can use a BPA Platform variable or formula to create a dynamic connection, where the connection

used is determined by runtime circumstances. At runtime, the contents of the variable must match the name of one

of the Global Configuration connections — this is case-sensitive.

About the Recordset Tab

The Recordset tab is only available when a recordset is chosen as the Data Source in the General tab . SAP

Business One only accepts XML from the SAP Business One (SL) Integration tool, therefore youmust use this tab to

create the XML structure expected by theMapping tab based on the parent and child relationships of an SAP

Business One object.

NOTE:Grand-parenting, that is, having an XML depth of more than one level, is not permitted.

An additional feature is that you can create an XML structure to enable looping on child elements of an object — for

example, adding multiple addresses and contact details to a single business partner. For such a case, you would

create the structure with a parent Key element which determine when a new header is found. For more information,

refer to our knowledge base article, The recommended SQL structure to generate multiple child records.
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The Recordset Columns pane displays the recordset columns as a flat list; the XML Structure pane displays the XML

as you build it.

Select Enable Recordset Shaping to map recordset data to an XML structure. However, if your recordset data is of

a simple structure, that is the recordset columns map to a flat XML structure, skip directly to theMapping tab.

The SAP Business One (SL) Integration tool creates a basic XML structure based on the recordset data source. To

set an XML element as the key, right-click on the XML element (right-hand pane) and select Set as Key.

TIP: If the XML structure you are creating contains multiple child elements, remove the XML elements from the

XML structure now (right-click on the field and select Remove) to ensure you don't create duplicate elements.

To create a new child element, right-click on the required recordset column name and select Add new child

element.

Provide a Name for the child element. This has a maximum of 64 characters and uses XML-supported characters

only. The new child element appears in the XML Structure pane with the chosen recordset column as a field.

To add a recordset column to the new child node, right-click on the relevant column name and select Add to. Repeat

until the child element has been built.

To remove a field from a child element, right-click on the field in the XML Structure pane and select Remove. To

remove a child element in its entirety, youmust remove each field first. Removing the final field removes the child

element.
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About theMapping Tab

TheMapping tab is used to define links between the incoming XML or recordset data source, and the outgoing data

that is to be sent to SAP Business One. Variables can also be included as an additional source for passing data

across.

The Object drop-down shows the SAP Business One objects. If exposed, user-defined fields and objects are also

made available for selection here. The Operations drop-down shows the operations available for the selected

Object

Further down, the left-hand XML tree structure shows those data source fields available for mapping . The right-hand

XML tree structure displays those input fields for the selectedObject andOperation.

TIP: If you have selectedNo data source in the General tab, youmust add BPA Platform formulas and variables

to the left-hand data source XML tree structure before mapping.

Creating Mappings

Create links by dragging and dropping a data source field (left) onto its corresponding SAP Business One (SL)

Integration input field (right). Only linked fields are used in the output XML.

BPA Platform formulas and variables can be included in the source data even when using a Task step or Custom

schema— drag them from the BPA Platform Browser to the data source’s XML; these can then be linked to the

relevant input fields. BPA Platform recordsets must first be converted to XML using either the Convert Recordset to

XML or TransformData tool before they can be used here.
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Each operation has an additional field, SupplementaryReference, which allows for traceability when transferring

data from one place to another. Whenmapped, the data resides locally at runtime. It is added to the output, and

creates a record for reference purposes only — you can choose to map any field to SupplementaryReference to

assist with checking where the data originated from or at what time the data transfer occurred, for example.

The SAP Business One (SL) Integration tool uses eXtensible Stylesheet Language Transformations (XSLT) to

translate the received XML. The Advanced Translations (XSLT) tab shows the XSLT generated for the links created

for the object and operation. Use Enable Free Type Mode to directly edit the XSLT — this is particularly useful when

translating a non-standard requirement.

Refreshing the SAP Business One (SL) Integration's Schema

If new fields, objects, and operations have been added to your SAP Business One company database after this task

step was originally created, use Schema Refresh to make the latest API metadata available for use.

NOTE:Newly defined fields and objects, whether user-defined or added by SAP Business One, are not

automatically available for mapping. Use Schema Refresh underneath the input field pane to download any

updates from the SAP Business One schema. If that doesn't work, youmust reset the SAP Business One (SL)

Integration tool's local cache — see Update Objects and Operations and Clear Metadata Cache— before

performing the Schema Refresh.

About User-Defined Objects

The SAP Business One (SL) Integration tool supports the use of user-defined objects, whether createdmanually or

imported from an external source into SAP. User-defined objects are exposed in the tool via the Object drop-down.

Each user-defined object contains the mandatory operations Add and Update, along with any other operation defined

during its creation.
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Any user-defined object that has the Log option enabled in SAP Business One has access to history data. Using the

SAP Business One (SL) Integration tool, you can retrieve the previous value of a field after an update occurs by

mapping a variable to it.

NOTE:Newly defined fields and objects, whether user-defined or added by SAP Business One, are not

automatically available for mapping. Use Schema Refresh underneath the input field pane to download any

updates from the SAP Business One schema. If that doesn't work, youmust reset the SAP Business One (SL)

Integration tool's local cache — see Update Objects and Operations and Clear Metadata Cache— before

performing the Schema Refresh.

About User-Defined Fields

The SAP Business One (SL) Integration tool supports the use of user-defined fields in both objects and sub-objects.

The field is prefixed with U_.

NOTE:Newly defined fields and objects, whether user-defined or added by SAP Business One, are not

automatically available for mapping. Use Schema Refresh underneath the input field pane to download any

updates from the SAP Business One schema. If that doesn't work, youmust reset the SAP Business One (SL)

Integration tool's local cache — see Update Objects and Operations and Clear Metadata Cache— before

performing the Schema Refresh.
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Supported Objects

NOTE: The following information is referenced from SAP Business One version 10.0. If your instance of SAP

Business One is on a different version, youmay find fields, objects, and operations differ slightly.

The objects and operations currently available are shown in the table below, where:

Key for Standard Operations

A— Add GK— GetByKey

Ca— Cancel GL— GetList

Cl— Close S— Search

D— Delete U— Update

WARNING: The SAP Business One Service Layer exposes the objects and operations via ODATA. At the time of

writing, all objects are exposed irrespective of the region your SAP Business One instance is configured for or the

patch level. Additionally, unless otherwise stated, all standard operations are available for every object, again

irrespective of your region and patch level. Care must be taken when creating your mappings — ensure you do

not map to objects and operations not supported by your region or patch level. If you are unsure about this, refer

to your SAP Business One documentation.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

AccountCategory     

AccountCategoryService Single supported operation:
GetCategoryList

AccountSegmentationCategories     

AccountSegmentations     

AccountsService Single supported operation:
CreateOpenBalance

AccrualTypes     
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SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

AccrualTypesService Single supported operation:
GetAccrualTypeList

Activities     

ActivitiesService Supported operations:
DeleteSingleInstanceFromSerie

s

GetActivityList

GetListByAttendUser

GetSingleInstanceFromSeries

GetTopNActivityInstances

InitData

UpdateSingleInstanceInSeries

ActivityLocations     

ActivityRecipientsLists     

ActivityRecipientsListsService 

ActivityStatuses     

ActivitySubjects     

ActivitySubjectService Supported operations:
GetActivitySubjectList

GetListByTypeCode

ActivityTypes     

AdditionalExpenses     

AlertManagements      Additional supported operation:
GetAlertManagementList

AlternateCatNum     

AlternativeItemsService Supported operations:
AddItem

DeleteItem

GetItem

UpdateItem

ApprovalRequests      Additional supported operations:
CancelApprovalRequest

RestoreApprovalRequest
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SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

ApprovalRequestsService Supported operations:
GetAllApprovalRequestsList

GetApprovalRequestList

GetOpenApprovalRequestList

ApprovalStages     

ApprovalStagesService Single supported operation:
GetApprovalStageList

ApprovalTemplates     

ApprovalTemplatesService Single supported operation:
GetApprovalTemplateList

AssetCapitalization     

AssetCapitalizationCreditMemo     

AssetCapitalizationCreditMemoS

ervice

 

AssetCapitalizationService  

AssetClasses     

AssetClassesService 

AssetDepreciationGroups     

AssetDepreciationGroupsService 

AssetGroups     

AssetGroupsService 

AssetManualDepreciation     

AssetManualDepreciationService  

AssetRetirement     

AssetRetirement  

AssetTransfer     

AssetTransferService  

Attachments2     
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SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

AttributeGroups     

AttributeGroupsService 

B1Sessions     

BankChargesAllocationCodes      Additional supported operation:
SetDefaultBankChargesAllocati

onCode

BankChargesAllocationCodesSer

vices

Single supported operation:
GetBankChargesAllocationCodeL

ist

BankPages     

Banks     

BankStatements     

BanksStatementsService Single supported operation:
GetBankStatementList

BarCodes     

BarCodesService 

BatchNumberDetails     

BillOfExchangeTransations     

BinLocationAttributes     

BinLocationAttributesService 

BinLocationFields     

BinLocationFieldsService 

BinLocations     

BinLocationsService 

BlanketAgreements      Additional supported operations:
CancelBlanketAgreement

GetRelatedDocuments

BlanketAgreementsService Single supported operation:
GetBlanketAgreementList
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BOEDoumentTypes     

BOEDoumentTypesService Single supported operation:
GetBOEDocumentTypeList

BOEInstructions     

BOEInstructionsService Single supported operation:
GetBOEInstructionList

BOELinesService Single supported operation:
GetBOELine

BOEPortfolios     

BOEPortfoliosService Single supported operation:
GetBOEPortfolioList

BPOpeningBalanceService Single supported operation:
CreateOpenBalance

BPPriorities     

Branches     

BranchesService Single supported operation:
GetBranchList

BrazilBeverageIndexers     

BrazilBeverageIndexersService 

BrazilFuelIndexers     

BrazilFuelIndexersServices 

BrazilMultiIndexers      Additional supported operation:
GetIndexerTypeList

BrazilNumericIndexers      Additional supported operation:
GetIndexerTypeList

BrazilStringIndexers      Additional supported operation:
GetIndexerTypeList

BudgetDistributions     

Budgets     
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BudgetScenarios     

BusinessPartnerGroups     

BusinessPartnerProperties     

BusinessPartnerPropertiesServic

e

Single supported operation:
GetBusinessPartnerPropertyLis

t

BusinessPartners     

BusinessPartnersService Supported operations:
CreateOpenBalance

InitData

BusinessPlaces     

CampaignResponseType     

CampaignResponseTypeService Single supported operation:
GetResponseTypeList

Campaigns      

CampaignsService 

CashDiscounts     

CashDiscountsService Single supported operation:
GetCashDiscountList

CashFlowLineItems     

CashFlowLineItemsService Single supported operation:
GetCashFlowLineItemList

CertificateSeries     

CertificateSeriesService Single supported operation:
GetCertificateSeriesList

ChangeLogsService Supported operations:
GetChangeLog

GetChangeLogDifferences

ChartOfAccounts     
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CheckLinesService Supported operations:
GetCheckLine

GetValidCheckLineList

ChecksforPayment     

ChooseFromList     

Cockpits     

CockpitsService Supported operations:
GetCockpitList

GetTemplateCockpitList

GetUserCockpitList

PublishCockpit

CommissionGroups     

CompanyService Supported operations:
CreatePeriod

CreatePeriodWithFinanceParams

GetAdminInfo

GetAdvancedGLAccount

GetCompanyInfo

GetFeaturesStatus

GetFinancePeriod

GetFinancePeriods

GetItemPrice

GetPathAdmin

GetPeriod

GetPeriods

RemoveFinancePeriod

RoundDecimal

UpdateAdminInfo

UpdateCompanyInfo

UpdateFinancePeriod

UpdatePathAdmin

UpdatePeriod

Contacts     

ContractTemplates     
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CorrectionInvoice        Additional supported operations:
CreateCancellationDocument

Reopen

CorrectionInvoiceReversal        Additional supported operations:
CreateCancellationDocument

Reopen

CorrectionInvoiceReversalServic

e

Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

CorrectionInvoiceService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

CorrectionPurchaseInvoice        Additional supported operations:
CreateCancellationDocument

Reopen

CorrectionPurchaseInvoiceRever

sal

       Additional supported operations:
CreateCancellationDocument

Reopen

CorrectionPurchaseInvoiceRever

salService

Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

CorrectionPurchaseInvoiceServic

e

Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

CostCenterTypes     

CostCenterTypesService Single supported operation:
GetCostCenterTypeList
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CostElements     

CostElementsService Single supported operation:
GetCostElementList

Countries     

CountriesService Single supported operation:
GetCountryList

CreditCardPayments     

CreditCards     

CreditLinesService Supported operations:
GetCreditLine

GetValidCreditLineList

CreditNotes        Additional supported operations:
CreateCancellationDocument

Reopen

CreditNotesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

RequestApproveCancellation

CreditPaymentMethods     

Currencies     

CustomerEquipmentCards     

CustomsDeclaration     

CustomsGroups     

CycleCountDetermines     

CycleCountDeterminesService 

DashboardPackagesService Single supported operation:
ImportDashboardPackage

DeductionTaxGroups     
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DeductionTaxHierarchies     

DeductionTaxSubGroups     

DeductionTaxSubGroupsService Single supported operation:
GetDeductionTaxSubGroupList

DefaultElementsforCR     

DeliveryNotes        Additional supported operations:
CreateCancellationDocument

Reopen

DeliveryNotesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

Departments     

DepartmentsService Single supported operation:
GetDepartmentList

Deposits      Additional supported operations:
CancelDeposit

CancelDepositbyCurrentSystemD

ate

DepositsService Supported operations:
CancelCheckRow

CancelCheckRowbyCurrentSystem

Date

GetDepositList

DepreciationAreas     

DepreciationAreasService 

DepreciationTypePools     

DepreciationTypePoolsService 

DepreciationTypes     

DepreciationTypesService 
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DeterminationCriterias     

DeterminationCriteriasService 

Dimensions     

DimensionsService Single supported operation:
GetDimensionList

DistributionRules     

DistributionRulesService Single supported operation:
GetDistributionRuleList

DNFCodeSetup     

DNFCodeSetupService Single supported operation:
GetDNFCodeSetupList

DownPayments        Additional supported operations:
CreateCancellationDocument

Reopen

DownPaymentsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

Drafts        Additional supported operations:
CreateCancellationDocument

Reopen

DraftsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

SaveDraftToDocument

DunningLetters     

DunningTerms     

DunningTermsService Single supported operation:
GetDunningTermList
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DynamicSystemsString     

ElectronicCommunicationActionS

ervice

Supported operations:
ConfirmSuccessOfCommunication

GetAction

ReportErrorAndContinue

ReportErrorAndStop

UpdateAction

ElectronicCommunicationActions

Service

Supported operations:
AddEcmAction

AddEcmActionLog

DeleteEcmAction

GetEcmAction

GetEcmActionByDoc

GetEcmActionLog

GetEcmActionLogList

UpdateEcmAction

ElectronicDocuments      Additional supported operation:
GetProtocolParameters

ElectronicDocumentService Supported operations:
AddLog

ExportEntryLog

GetEntry

GetEntryList

GetLastLog

GetLogs

GetProtocols

UpdateEntry

ElectronicFileFormats     

ElectronicFileFormatsService Single supported operation:
GetElectronicFileFormatList

EmailGroups     

EmailGroupsService 

EmployeeIDType     

EmployeeIDTypeService 
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EmployeePosition     

EmployeePositionService 

EmployeeRolesSetup     

EmployeeRolesSetupService Single supported operation:
GetEmployeeRoleSetupList

EmployeesInfo       

EmployeeStatus     

EmployeeStatusService 

EmployeeTransfers     

EmployeeTransfersService Single supported operation:
GetEmployeeTransferList

EnhancedDiscountGroups     

EnhancedDiscountGroupsService 

EWBTransports     

EWBTransporterService Single supported operation:
GetEWBTransporterList

ExpenseTypes     

ExtendedTranslations     

ExtendedTranslationsService Single supported operation:
GetExtendedTranslationList

ExternalCallsService Supported operations:
GetCall

SendCall

UpdateCall

ExternalReconciliationsService Supported operations:
CancelReconciliation

GetReconciliation

GetReconciliationList

Reconcile

FAAccountDeterminations     
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FAAccountDeterminationsServic

e



FactoringIndicators     

FinancialYears     

FinancialYearsService Single supported operation:
GetFinancialYearList

FiscalPrinter     

FiscalPrinterService Single supported operation:
GetFiscalPrinterList

FixedAssetItemsService Supported operations:
GetAssetEndBalance

GetAssetValuesList

UpdateAssetEndBalance

FormattedSearches     

FormPreferences     

Forms1099     

GLAccountAdvancedRules     

GLAccountAdvancedRulesService 

GoodsReturnRequest        Additional supported operations:
CreateCancellationDocument

Reopen

GoodsReturnRequestService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

GovPayCodes     

GovPayCodesService 

GTIsService Single supported operation: Import

HouseBankAccounts     
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IncomingPayments       Additional supported operations:
CancelbyCurrentSystemDate

GetApprovalTemplates

SaveDraftToDocument

IndiaSacCode     

IndiaSacCodeService 

Industries     

IntegrationPackagesConfigure     

IntegrationPackagesConfigureSe

rvice



InternalReconciliations       Additional supported operation:
RequestApproveCancellation

InternalReconciliationsService Single supported operation:
GetOpenTransactions

IntrastatConfiguration     

IntrastatConfigurationService 

InventoryCountings      

InventoryCountingsService 

InventoryCycles     

InventoryGenEntries        Additional supported operations:
CreateCancellationDocument

Reopen

InventoryGenEntriesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

InventoryGenExits        Additional supported operations:
CreateCancellationDocument

Reopen

85 of 103



SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

InventoryGenExitService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

InventoryOpeningBalances     

InventoryOpeningBalancesServic

e



InventoryPostings     

InventoryPostingsService  Additional supported operation:
SetCopyOption

InventoryTransferRequests        Additional supported operations:
SaveDraftToDocument

InventoryTransferRequestsServic

e

Supported operations:
GetApprovalTemplates

HandleApprovalRequest

Invoices        Additional supported operations:
CreateCancellationDocument

Reopen

InvoicesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

ItemGroups     

ItemImages     

ItemProperties     

Items      

ItemService Single supported operation:
InitData

JournalEntries      

JournalEntryDocumentTypes     
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JournalEntryDocumentTypeServi

ce



JournalVouchersService 

KnowledgeBaseSolutions     

KPIs     

KPIsService 

LandedCosts      Additional supported operations:
CancelLandedCost

CloseLandedCost

LandedCostsCodes     

LandedCostsService Single supported operation:
GetLandedCostList

LegalData     

LengthMeasures     

LicenseService Single supported operation:
GetInstallationNumber

LocalEra     

Manufacturers     

MaterialGroups     

MaterialGroupsService Single supported operation:
GetMaterialGroupList

MaterialRevaluation       

MaterialRevaluationFIFOService Single supported operation:
GetMaterialRevaluationFIFO

MaterialRevaluationSNBService  

Messages     

MessagesService Supported operations:
GetInbox

GetOutbox

GetSentMessages
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MobileAddOnSetting     

MobileAddOnSettingService Single supported operation:
GetMobileAddOnSettingList

MobileAddService Supported operations:
GetCurrentServerDateTime

GetDppChangeParams[SIC]

GetEmployeeFullNames

GetSalesAppSetting

GetServiceAppReport

GetServiceAppReportContent

GetTechnicianSchedulings

GetTechnicianSettings

GetTechnicianSettingsGroup

UpdateSalesAppSetting

UpdateServiceAppReport

UpdateServiceAppReportContent

UpdateTechnicianSettings

UpdateTechnicianSettingsGroup

MultiLanguageTranslations     

NatureOfAssessees     

NatureOfAssesseesService Single supported operation:
GetNatureOfAssesseeList

NCMCodesSetup     

NCMCodesSetupService Single supported operation:
GetNCMCodeSetupList

NFModels     

NFModelsService 

NFTaxCategories     

NFTaxCategoriesServices 

OccurrenceCodes     

OccurrenceCodesService 
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Orders        Additional supported operations:
CreateCancellationDocument

Reopen

OrdersService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

Preview

PackagesTypes     

PartnersSetups     

PartnersSetupsService 

PaymentBlocks     

PaymentBlocksService Single supported operation:
GetPaymentBlockList

PaymentCalculationService Single supported operation:
GetPaymentAmount

PaymentDrafts       Additional supported operations:
CancelbyCurrentSystemsDate

GetApprovalTemplates

RequestApproveCancellation

SaveDraftToDocument

PaymentRunExport     

PaymentTermsTypes      

PaymentTermsTypesService Single supported operation:
UpdateWithBPs

PickLists      Additional supported operation:
GetReleasedAllocation

PickListsService  Additional supported operation:
UpdateReleasedAllocation

POSDailySummary     

PostingTemplates     
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PostingTemplatesService 

PredefinedTexts     

PredefinedTextsService Single supported operation:
GetPredefinedTextList

PriceLists     

ProductionOrders      

ProductTrees     

ProfitCenters     

ProfitCentersService Single supported operation:
GetProfitCenterList

ProjectManagementConfiguratio

nService

Supported operations:
AddActivities

AddAreas

AddPriorities

AddStageTypes

AddSubprojectTypes

AddTasks

DeleteActivities

DeleteAreas

DeletePriorities

DeleteStageTypes

DeleteSubprojectTypes

DeleteTasks

GetActivities

GetAreas

GetPriorities

GetStageTypes

GetSubprojectTypes

GetTasks

UpdateActivities

UpdateAreas

UpdatePriorities

UpdateStageTypes

UpdateSubprojectTypes

UpdateTasks
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ProjectManagements      Additional supported object:
CancelProject

ProjectManagementsService Supported operations:
AddSubproject

DeleteSubproject

GetSubproject

GetSubprojectsList

UpdateSubproject

ProjectManagementTimeSheet     

Projects     

ProjectsService Single supported operation:
GetProjectList

PurchaseCreditNotes        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseCreditNotesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseDeliveryNotes        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseDeliveryNotesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseDownPayments        Additional supported operations:
CreateCancellationDocument

Reopen
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PurchaseDownPaymentsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseInvoices        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseInvoicesService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseOrders        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseOrdersService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseQuotations        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseQuotationsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseRequests        Additional supported operations:
CreateCancellationDocument

Reopen
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PurchaseRequestsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseReturns        Additional supported operations:
CreateCancellationDocument

Reopen

PurchaseReturnsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

PurchaseTaxInvoices     

QRCodeService Single supported operation:
AddOrUpdateQRCode

QueryAuthGroups     

QueryAuthGroupsService Single supported operation:
GetQueryAuthGroupList

QueryCategories     

QueryService Single supported operation:
PostQuery

Queue     

Quotations        Additional supported operations:
CreateCancellationDocument

Reopen

QuotationsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

RecurringPostings     

RecurringPostingsService 
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RecurringTransactionService Supported operations:
DeleteRecurringTransactions

ExecuteRecurringTransactions

GetAvailableRecurringTransact

ions

GetRecurringTransactions

Relationships     

ReportFilter     

ReportFilterService Single supported operation:
GetTaxReportFilterList

ReportLayoutsService Supported operations:
AddReportLayout

AddReportLayoutToMenu

DeleteReportLayout

DeleteReportLayoutAndMenu

GetDefaultReport

GetDefaultReportLayout

GetReportLayout

GetReportLayoutList

SetDefaultReport

UpdateLanguageReport

UpdatePrinterSettings

ReportTypes     

ReportTypesService Single supported operation:
GetReportTypeList

ResourceCapabilities     

ResourceCapabilitiesService  Additional supported operation:
GetListWithFilter

ResourceGroups     

ResourceGroupsService 

ResourceProperties     

ResourcePropertiesService 

94 of 103



SAP B1 Objects
Standard Operations

Comments
A U GK GL D S Ca Cl

Resources      Additional supported operation:
CreateLinkedItem

ResourcesService 

RetornoCodes     

RetornoCodesService 

ReturnRequest        Additional supported operations:
CreateCancellationDocument

Reopen

ReturnRequestService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

Returns        Additional supported operations:
CreateCancellationDocument

Reopen

ReturnsService Supported operations:
ExportEWayBill

GetApprovalTemplates

HandleApprovalRequest

InitData

RouteStages     

RouteStagesService 

RoutingDataCalculationService Single supported operation:
Calculate

SalesForecast     

SalesOpportunities      

SalesOpportunityCompetitorsSet

up

    

SalesOpportunityCompetitorsSet

upService

Single supported operation:
GetSalesOpportunityCompetitor

SetupList
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SalesOpportunityInterestsSetup     

SalesOpportunityInterestsSetupS

ervice

Single supported operation:
GetSalesOpportunityInterestSe

tupList

SalesOpportunityReasonsSetup     

SalesOpportunityReasonsSetupS

ervice

Single supported operation:
GetSalesOpportunityReasonsSet

upList

SalesOpportunitySourcesSetup     

SalesOpportunitySourcesSetupS

ervice

Single supported operation:
GetSalesOpportunitySourceSetu

pList

SalesPersons     

SalesStages     

SalesTaxAuthorities     

SalesTaxAuthoritiesTypes     

SalesTaxCodes     

SalesTaxInvoices     

SBOBobService Supported operations:
MoneyToString

GetCurrencyRate

GetDueDate

GetIndexRate

GetLocalCurrency

GetSystemCurrency

GetSystemPermission

SetCurrencyRate

Sections     

SectionsService Single supported operation:
GetSectionList
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SensitiveDataAccessService Supported opertions:
Access

IsDataSensitive

SerialNumberDetails     

SeriesService Supported operations:
AddElectronicSeries

AddSeries

AttachSeriesToDocument

ChangeDocumentMenuName

GetDefaultElectronicSeries

GetDefaultSeries

GetDocumentChangedMenuName

GetDocumentSeries

GetElectronicSeries

GetSeries

RemoveElectronicSeries

RemoveSeries

SetDefaultElectronicSeries

SetDefaultSeriesForAllUsers

SetDefaultSeriesForCurrentUse

r

SetDefaultSeriesForUser

UnattachSeriesFromDocument

UpdateElectronicSeries

UpdateSeries

ServiceCallOrigins     

ServiceCallOriginsService Single supported operation:
GetServiceCallOriginList

ServiceCallProblemSubTypes     

ServiceCallProblemSubTypeServi

ce

Single supported operation:
GetServiceCallProblemSubTypeL

ist

ServiceCallProblemTypes     

ServiceCallProblemTypesService Single supported operation:
GetServiceCallProblemTypeList

ServiceCalls      
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ServiceCallSolutionStatus     

ServiceCallSolutionStatusService Single supported operation:
GetServiceCallSolutionStatusL

ist

ServiceCallStatus     

ServiceCallStatusService Single supported operation:
GetServiceCallStatusList

ServiceCallTypes     

ServiceCallTypesService Single supported operation:
GetServiceCallTypeList

ServiceContracts       

ServiceGlobalActions Supported operations:
Login

Logout

ServiceGroups     

ServiceGroupsService Single supported operation:
GetServiceGroupList

ServiceTaxPostingService Supported operations:
GetTaxableDeliveries

PostServiceTax

ShippingTypes     

SingleUserConnections     

SpecialPrices     

SQLViews      Additional supported operations:
Expose

Unexpose

States     

StatesService Single supported operation:
GetStateList

StockTakings     
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StockTransferDrafts        Additional supported operation:
SaveDraftToDocument

StockTransferDraftsService Supported operations:
GetApprovalTemplates

HandleApprovalRequest

StockTransfers        Additional supported operation:
SaveDraftToDocument

StockTransferService Supported operations:
GetApprovalTemplates

HandleApprovalRequest

TargetGroups     

TargetGroupsService 

TaxCodeDeterminations     

TaxCodeDeterminationsService Single supported operation:
GetTaxCodeDeterminationList

TaxCodeDeterminationsTCD     

TaxCodeDeterminationsTCDServ

ice

Single supported operation:
GetTaxCodeDeterminationTCDLis

t

TaxInvoiceReport      Additional supported operation:
CancelTaxInvoiceReport

TaxWebSites      Additional supported operation:
SetAsDefault

TaxWebSitesService Supported operations:
GetDefaultWebSite

GetTaxWebSiteList

Teams     

TerminationReason     

TerminationReasonService 

Territories     

TrackingNotes     
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TrackingNotesService 

TransactionCodes     

TransactionCodesService 

TransportationDocument      Additional supported operation:
CancelTransportationDocument

UnitOfMeasurementGroups     

UnitOfMeasurementGroupsServi

ce



UnitOfMeasurements     

UnitOfMeasurementsService 

UserDefaultGroups     

UserFieldsMD     

UserGroups     

UserGroupsService Single supported operation:
GetUserGroupList

UserKeysMD     

UserLanguages     

UserMenuService Supported operations:
GetCurrentUserMenu

GetUserMenu

UpdateCurrentUserMenu

UpdateUserMenu

UserObjectsMD     

UserPermissionTree     

UserQueries     

Users      

UserTablesMD     

ValueMapping     
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ValueMappingCommunication     

ValueMappingService Supported operations:
GetMappedB1Vlaue

GetThirdPartyValuesForB1Value

RemovedMappedValue

VatGroups     

VendorPayments       Additional supported operations:
CancelbyCurrentSystemDate

GetApprovalTemplates

RequestApproveCancellation

SaveDraftToDocument

WarehouseLocations     

Warehouses     

WarehouseSublevelCodes     

WarehouseSublevelCodesServic

e



WebClientBookmarkTiles     

WebClientBookmarkTilesService 

WebClientDashboards     

WebClientDashboardService 

WebClientFormSettings     

WebClientFormSettingService 

WebClientLaunchpads     

WebClientLaunchpadService 

WebClientListviewFilters     

WebClientListviewFilterService 

WebClientNotifications     

WebClientNotificationService 

WebClientPreferences     
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WebClientPreferenceService 

WebClientRecentActivities     

WebClientRecentActivityServices 

WebClientVariantGroups     

WebClientVariantGroupService 

WebClientVariants     

WebClientVariantService 

WeightMeasures     

WithholdingTaxCodes     

WitholdingTaxDefinition [SIC]     

WizardPaymentMethods     

WorkflowTaskService Supported operations:
Complete

GetApprovalTaskList
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About theOptions Tab

The Options tab allows you to define how errors in this step are handled at task runtime.

If an error occurs, you can decide whether the step should Continue processing, or terminate the step immediately

(Abort Step).

If the step is aborted, you can choose to Continue processing onto the next step in the task, or terminate the

whole task immediately (Abort Task). By allowing the task to Continue, you can use the error XML received back in a

Save File step for investigation purposes, for example.

103 of 103



Want to learn more?

Discover how Codeless Platforms can help your business by improving 
performance, boosting efficiency and cutting costs.
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